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Introduction 

The aim of this report is to present an IoT-based robot designed 

to assist doctors in the medical field, particularly during the 

COVID-19 pandemic. The system utilizes an Arduino UNO board 

to control a robotic arm equipped with servo motors. Wireless 

communication is established through a Bluetooth module, 

enabling control commands from an Android app. This 

innovative solution aims to support healthcare professionals 

and enhance their efforts in providing effective and safe care to 

patients. 

The system uses an Arduino UNO board that controls the  

movement robotic arm through Servo motors. The Arduino Uno 

board is connected with a Bluetooth module for wireless 

connection of android devices. An android app is used to provide 

commands to the robotic arm. We are engineers, we cannot do 

the doctor’s work, but can make a big difference by providing 

solutions which can support and reduce their novel efforts. 

 

System Overview 

The IoT-based robot system consists of the following components: 

Arduino UNO board: It serves as the central control unit, responsible for processing 

commands and controlling the movements of the robotic arm. 

Robotic Arm: Equipped with servo motors, the arm mimics human movements and 

performs tasks as directed by the controlling system. 

Bluetooth Module: Enables wireless communication between the Arduino UNO board 

and the Android app. 
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Android App: Allows doctors to send commands to the robotic arm, providing a user-

friendly interface for seamless control and operation. 

 

Objectives and Features 

The primary objectives of the IoT-based robot in the medical field are: 

 Assisting doctors by reducing their workload and minimizing exposure to potentially 

infectious environments. 

 Enhancing precision and accuracy in performing medical tasks, such as 

administering medicines or collecting samples. 

 Enabling remote operation and monitoring, allowing doctors to control the robot 

from a safe distance. 

 

Key features of the system include: 

 Control Interface: The Android app provides an intuitive interface for doctors to 

send commands to the robotic arm, ensuring ease of use and seamless operation. 

 Wireless Connectivity: The integration of the Bluetooth module enables wireless 

communication, eliminating the need for physical connections and allowing 

flexibility in controlling the robot. 

 Servo Motor-Controlled Robotic Arm: The robotic arm replicates human arm 

movements and can perform a wide range of tasks, making it versatile and adaptable 

to various medical procedures. 

 

Applications in the Medical Field 

The IoT-based robot has several applications in the medical field, especially in the context 

of COVID-19: 

 Patient Monitoring: The robot can be equipped with sensors to collect and transmit 

patient vitals, providing real-time data to healthcare professionals for remote 

monitoring. 

 Medication Administration: With precise control, the robot can assist in 

administering medicines or intravenous fluids, ensuring accurate dosage and 

reducing the risk of human errors. 

 Sample Collection: The robot can be used to collect samples from patients, 

minimizing direct contact and reducing the risk of cross-contamination. 
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 Disinfection and Sanitization: By integrating additional modules, the robot can be 

equipped to perform autonomous disinfection and sanitization tasks, minimizing the 

spread of infectious diseases. 

 Benefits and Impact 

The IoT-based robot offers numerous benefits and can have a significant impact in 

the medical field: 

 Enhanced Safety: By reducing direct contact between doctors and patients, the risk 

of infection transmission is minimized, ensuring the safety of both healthcare 

professionals and patients. 

 Increased Efficiency: The robot can perform tasks with precision and consistency, 

reducing human errors and improving overall efficiency in medical procedures. 

 Remote Operation: Doctors can remotely control the robot, allowing them to attend 

to multiple patients simultaneously and efficiently manage their time. 

 Support in Critical Situations: During emergencies or outbreaks, the robot can 

provide valuable support, augmenting the limited resources and manpower 

available. 

 

System Specifications  

Project Category : IOT Based Project 

An IoT ecosystem consists of web-enabled smart devices that use embedded systems, 

such as processors, sensors and communication hardware, to collect, send and act on data 

they acquire from their environments. IoT devices share the sensor data they collect by 

connecting to an IoT gateway or other edge device where data is either sent to the cloud 

to be analyzed or analyzed locally. Sometimes, these devices communicate with other 

related devices and act on the information they get from one another. The devices do 

most of the work without human intervention, although people can interact with the 

devices -- for instance, to set them up, give them instructions or access the data. 

The connectivity, networking and communication protocols used with these web-

enabled devices largely depend on the specific IoT applications deployed. 

IoT can also make use of artificial intelligence (AI) and machine learning to aid in making 

data collecting processes easier and more dynamic.The Internet of things (IoT) describes 

the network of physical objects—“things”—that are embedded with sensors, software, 
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and other technologies for the purpose of connecting and exchanging data with other 

devices and systems over the Internet. 

Things have evolved due to the convergence of multiple technologies, real-time analytics, 

machine learning, commodity sensors, and embedded systems.Traditional fields of 

embedded systems, wireless sensor networks, control systems, automation (including 

home and building automation), and others all contribute to enabling the Internet of 

things. In the consumer market, IoT technology is most synonymous with products 

pertaining to the concept of the "smart home", including devices and appliances (such as 

lighting fixtures, thermostats, home security systems and cameras, and other home 

appliances) that support one or more common ecosystems, and can be controlled via 

devices associated with that ecosystem, such as smartphones and smart speakers. IoT can 

also be used in healthcare systems. 

  

Software Requirement Specification 

The Arduino IDE   

The Arduino Integrated Development Environment - or Arduino Software (IDE) - 

contains a text editor for writing code, a message area, a text console, a toolbar with 

buttons for common functions and a series of menus. It connects to the Arduino and 

Genuino hardware to upload programs and communicate with them. 

 

Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension. ino. The editor has features 

for cutting/pasting and for searching/replacing text. The message area gives feedback 

while saving and exporting and also displays errors. The console displays text output by 

the Arduino Software (IDE), including complete error messages and other information. 

The bottom right-hand corner of the window displays the configured board and serial 

port. The toolbar buttons allow you to verify and upload programs, create, open, and save 

sketches, and open the serial monitor. 

Verify 

Checks your code for errors compiling it. 
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Upload 

Compiles your code and uploads it to the configured board. See uploading below for 

details. 

  

Sketchbook 

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store 

your programs (or sketches). The sketches in your sketchbook can be opened from the 

File > Sketchbook menu or from the Open button on the toolbar. The first time you run 

the Arduino software, it will automatically create a directory for your sketchbook. You 

can view or change the location of the sketchbook location from with the Preferences 

dialog.  

 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board 

and Tools > Port menus. The boards are described below. On the Mac, the serial port is 

probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) 

or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for USB serial devices in the 

ports section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx, 

/dev/ttyUSBx or similar. Once you've selected the correct serial port and board, press the 

upload button in the toolbar or select the Upload item from the Sketch menu. Current 

Arduino boards will reset automatically and begin the upload. With older boards (pre-

Diecimila) that lack auto-reset, you'll need to press the reset button on the board just 

before starting the upload. On most boards, you'll see the RX and TX LEDs blink as the 

sketch is uploaded. The Arduino Software (IDE) will display a message when the upload 

is complete, or show an error. 

 

Hardware Requirement Specification 

Hardware requirement for body of Robot: 

 Metal sheet 10 kg 

 Wooden sheet 
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 Glue gun 

 Nails and drilling machine 

 PVC pipes 

 PPE kit 

 High performance whe 

Hardware components required for lower body of Robot: 

 Relays 

 Arduino Uno 

 300 RPM left side torque DC motors 

 Jumper wires 

 Switch 

 12 volt battery DC 

 Bluetooth HC 5 Module 

 

 

A Prototype Model of the CRD Robot 

Results and Analysis 

Overview of the work done 

The body is a main part of a robot which will  be strongest as well as lowest price to purchase 

for that by the i research in the market so the conclusion is metal sheet. The  metal sheet  is the 
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strongest material and affordable to the body of a robot we used  box structure  of metals in 

such a way that it it look like a robot of three types or boxes we made the the details of the 

boxes given below. 

 

Conclusion and Future Scope 

Conclusion of the project  

Robots are created by human to help them in several aspects of our life. The quick 

developing of robotics during the last century made robots be everywhere. Because 

medicine is an important issue still now, it was obvious to link robotics and medicine. 

And this is how the first medical robots appeared. We have come a long way since that 

moment. Medical robotics is improving very quickly, this is why the last ten years hosted 

the most impressive inventions ever made in this domain. 

But we can notice that before that, a lot of improvements need to be made and that these 

robots are far from being perfect. 

And the main disadvantage which is about money is not going to disappear. On the 

contrary, the more robots will be developed in the future, the more they will be expensive. 

Money is the biggest issue about medical robotics. 

The cost and the maintenance of these robots are so expensive that just a few hospitals 

have it. And even like that all patients can't do it because these operations are not totally 

repaid by the social welfare and are expensive. Ethic problems exist too, not everyone is 

ready to be operated by a robot.  
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The IoT-based robot designed for assisting doctors in the medical field during the COVID-

19 pandemic showcases the potential of technology in healthcare. By combining Arduino-

based control, wireless communication, and a versatile robotic arm, the system offers 

enhanced safety, efficiency, and remote operation capabilities. This innovative solution 

can significantly aid healthcare professionals in delivering effective care, reducing their 

workload, and mitigating the risks associated with infectious diseases. 

 

Future Scope 

We can install  FPV  camera : 

Generally robot is a mix of electronic, electrical and mechanical engineering and can do 

the tasks automatically on its own or under the supervision of humans. The camera is the 

eye for robot, call as robovision helps in monitoring security system and also can reach 

into the places where the human eye cannot reach.                    

Microphone: 

It is believed that providing robots with auditory capabilities such as microphones will 

help in improving the life of the hearing impaired and also be able to recognize speech 

and converse with humans. Microphones are transducers that detect sound signals and 

convert them into electric signals. 

For video conference: 

 The help of the video conference by the robot we can connect the doctors all over the 

world under a single roof for saving the time and money between the less time the doctor 

can give the service to the more people in very less time . 

Radio Frequency : 

Radio Frequency As  compared to the other thing like bluetooth ,the radio frequency has 

more powerful communication device and it also has more range then the bluetooth it is 

also very easy to use and compact in size  and easy to travel or move from one place to 

another place. 

Ultrasonic sensor 

An ultrasonic sensor is an electronic device that measures the distance of a target object 

by emitting ultrasonic sound waves, and converts the reflected sound into an electrical 

signal. Ultrasonic waves travel faster than the speed of audible sound (i.e. the sound that 

humans can hear). Ultrasonic sensors have two main components: the transmitter (which 
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emits the sound using piezoelectric crystals) and the receiver (which encounters the 

sound after it has travelled to and from the target). 

In order to calculate the distance between the sensor and the object, the sensor measures 

the time it takes between the emission of the sound by the transmitter to its contact with 

the receiver. The formula for this calculation is D = ½ T x C (where D is the distance, T is 

the time, and C is the speed of sound ~ 343 meters/second). For example, if a scientist 

set up an ultrasonic sensor aimed at a box and it took 0.025 seconds for the sound to 

bounce back, the distance between the ultrasonic sensor and the box would be.  
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CDR Side and Front View 
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CDR base in the preparatory pahse. 

 

 

CDR Base with Circuit connections 
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Circuit diagram 

 

Sample Tray of CDR 
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The Team with Hon’ble Director and Completed CDR with Project students 


